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Legal Information

Legal Information
The Schneider Electric brand and any registered trademarks of Schneider Electric Industries
SAS referred to in this guide are the sole property of Schneider Electric SA and its subsidiaries.
They may not be used for any purpose without the owner's permission, given in writing. This
guide and its content are protected, within the meaning of the French intellectual property code
(Code de la propriété intellectuelle français, referred to hereafter as "the Code"), under the laws
of copyright covering texts, drawings and models, as well as by trademark law. You agree not
to reproduce, other than for your own personal, noncommercial use as defined in the Code, all
or part of this guide on any medium whatsoever without Schneider Electric's permission, given
in writing. You also agree not to establish any hypertext links to this guide or its content. Schneider Electric does not grant any right or license for the personal and noncommercial use of
the guide or its content, except for a non-exclusive license to consult it on an "as is" basis, at
your own risk. All other rights are reserved.
Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.
As standards, specifications and designs change from time to time, please ask for confirmation
of the information given in this publication.

© 2016 Schneider Electric. All rights reserved.

Page 3 of 100

Legal Information

Page 4 of 100

© 2016 Schneider Electric. All rights reserved.

Safety Information

Safety Information
Important Information
Read these instructions carefully and look at the equipment to become familiar with
the device before trying to install, operate, service or maintain it. The following special
messages may appear throughout this bulletin or on the equipment to warn of potential hazards or to call attention to information that clarifies or simplifies a procedure.
The addition of either symbol to a "Danger" or "Warning" safety label
indicates that an electrical hazard exists which will result in personal
injury if the instructions are not followed.
This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey all safety messages that follow this symbol
to avoid possible injury or death.

DANGER
DANGER indicates a hazardous situation which, if not avoided, will result in death or serious injury.

WARNING
WARNING indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

CAUTION
CAUTION indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

NOTICE
NOTICE is used to address practices not related to physical injury.

Please Note
Electrical equipment should be installed, operated, serviced and maintained only by qualified
personnel. No responsibility is assumed by Schneider Electric for any consequences arising
out of the use of this material.
A qualified person is one who has skills and knowledge related to the construction, installation,
and operation of electrical equipment and has received safety training to recognize and avoid
the hazards involved.
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Safety Precautions
During installation or use of this software, pay attention to all safety messages that occur in the
software and that are included in the documentation. The following safety messages apply to
this software in its entirety.

WARNING
UNINTENDED EQUIPMENT OPERATION
Do not use the software for critical control or protection applications where human or
equipment safety relies on the operation of the control action.
Do not use the software to control time-critical functions because communication delays
can occur between the time a control is initiated and when that action is applied.
Do not use the software to control remote equipment without securing it with an authorized access level, and without including a status object to provide feedback about the
status of the control operation.
Failure to follow these instructions can result in death or serious injury.

WARNING
INACCURATE DATA RESULTS
Do not incorrectly configure the software, as this can lead to inaccurate reports and/or
data results.
Do not base your maintenance or service actions solely on messages and information displayed by the software.
Do not rely solely on software messages and reports to determine if the system is functioning correctly or meeting all applicable standards and requirements.
Consider the implications of unanticipated transmission delays or failures of communications links.
Failure to follow these instructions can result in death, serious injury, equipment
damage, or permanent loss of data.

© 2016 Schneider Electric. All rights reserved.

Page 7 of 100

Safety Precautions

Page 8 of 100

© 2016 Schneider Electric. All rights reserved.

Contents

Contents
StruxureWare™ Power Monitoring Expert
Side-by-Side Upgrade Guide

1
1

Legal Information

3

Safety Information

5

Safety Precautions

7

Contents

9

Introduction

13

Side-by-side Upgrade

13

Side-by-side Upgrade Package

13

Purpose

14

Challenges

14

Configurations

14

Prerequisites

15

Custom Report Packs

16

Competencies

17

Estimated Upgrade Time

17

Glossary

18

Upgrade Process
Step 1 – Prepare both Systems

21
22

Assess the Old System

22

Assess the New System

23

License the New System

23

Prepare the Side-by-side Upgrade Package

24

Step 2 – Copy the Configuration of the Old System

27

Copy Database Backups and Archives

27

Copy config Folder

30

Custom Report Packs

31

Copy Report Subscriptions

32

Step 3 – Identify Settings that must be Individually Transferred
Scheduled Tasks on the Old System

© 2016 Schneider Electric. All rights reserved.

34
34

Page 9 of 100

Contents

OPC Measurement Definitions

34

Registry Settings

34

ION Login Password

36

Dashboard Images

36

Step 4 – Transfer the Configuration into the New System
Prepare the New System

37

Copy the SBS Upgrade Package to the New System

38

Transfer config Folder

38

Transfer Dashboard Images

39

Connect the Old Databases

40

Import Custom Report Packs

48

Import Report Subscriptions

49

Step 5 – Upgrade the Transferred Configuration

51

Upgrade ION_Data, ION_Network, and archived databases

51

Upgrade ApplicationModules Database

53

Update Server Name

56

Delete old Log Inserter and Query Server Folders

62

Register Custom VIPs

63

Install the Report Subscriptions

64

Update SQL Server Logins

65

Update SQL Server name for PQDIF reports

66

Reconfigure PME 8.1

67

Install Custom Web Report Packs

68

System Reboot

70

Step 6 – Configure the Individually Transferred Settings

Page 10 of 100

37

71

Scheduled Tasks

71

Vista Diagram Links

72

OPC Measurement Definitions

73

Web Report Subscription Parameters

73

Update RepGen Report Parameters

75

Registry Settings

78

ION Login Password

79

Clear Browser Cache

80

Upgrade Custom Device Drivers

80

© 2016 Schneider Electric. All rights reserved.

Contents

Step 7 – Perform a Post-upgrade System Check
Checklist
Reference

82
82
83

Supplemental Information

83

Default Device Drivers

84

Troubleshooting

85

© 2016 Schneider Electric. All rights reserved.

Page 11 of 100

Contents

Page 12 of 100

© 2016 Schneider Electric. All rights reserved.

Introduction

Introduction
Each field deployed StruxureWare Power Monitoring (SPM) 7.0.1 system is unique. Some
systems have been modified very little from the factory defaults, while others may have been
completely customized. In SPM, the various configuration items and settings are stored in different locations and in different formats. Most of the configuration items and settings stored in
a file or in the database are easy to migrate in bulk to the new system; however, a few must
be recreated individually in the new system.
This guide is designed to help you move an old SPM configuration to a new PME 8.1 system.

Note: In this document, PME 8.1 is used when discussing the procedural steps.
However, these steps also apply to the following versions:
PME 8.1 Data Center Edition
PME 8.1 Healthcare Edition

Side-by-side Upgrade
A side-by-side upgrade is used when an older version of the software is upgraded to a newer
version, and the software needs to be moved to a new computer. This type of upgrade is
referred to as side-by-side because both systems—the old and the new—exist at the same
time but on different computers.
Common reasons for moving the software to a new computer during an upgrade include:
Either the operating system (OS) version or the database (DB) server version or
both on the old SPM system is no longer supported in the new system.
The computer hardware of the old SPM system is outdated and needs to be
replaced or upgraded.
The old system cannot be decommissioned until the new system is fully deployed.
You want to start with a fresh computer environment for the installation of the new
version of the software but retain the configuration of the old system.

Side-by-side Upgrade Package
This guide assumes that you are using the Side-by-Side (SBS) Upgrade Package to assist in
the upgrade process. The SBS Upgrade Package contains upgrade tools and a folder structure to help you organize and prepare both systems for upgrade.

© 2016 Schneider Electric. All rights reserved.
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Note: Depending on the old and new systems, you might not need to use all the
folders in the SBS Upgrade Package. For example, if you are not upgrading a data
center, ignore the Data_Center_Images folder.

Purpose
This document is intended for Application Engineers, system integrators, or other qualified
project execution teams who are responsible for the upgrading and configuration of an old
SPM system to a newly installed PME 8.1 system on a different computer using the side-byside approach. It includes step-by-step instructions and defines prerequisites for the tasks
involved. Experience using previous versions of the software is recommended.

Challenges
The challenges with completing this system migration include:
There is no automated way to transfer the configuration.
Many variations of the operating system (OS) and database (DB) systems are possible.
PME can be installed as a standalone or distributed system.
The migration can be time consuming.
Many configuration items and settings need to be migrated.
This document addresses these challenges and provides the necessary information and procedures to plan and execute the migration successfully. However, each migration in the field
provides new challenges and risks that need to be assessed and managed.
Areas not discussed in this document include integration with third party systems. Make sure
you understand the application environment in which the PME system exists so you can
include this in your migration plan.
When in doubt regarding any aspect of the migration, contact Schneider Electric technical
support engineers to discuss the migration before going on site.

Configurations
PME 8.1 supports a number of different OS and DB versions and can be installed as standalone or distributed systems. Because of this version support, there are a large number of
possible migration scenarios between the old SPM system and the new PME system. For a
comprehensive list of options, refer to the Power Monitoring Expert 8.1 Installation Guide that
is delivered with the software.
Below are some examples of common configurations.
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Old system: SPM 7.0.1
Small Power Monitoring Expert Large Power Monitoring Expert
OS: Windows 7

Windows Server 2008

DB: SQL Server 2008 Express

SQL Server 2008 Standard

New system: PME 8.1
Small Power Monitoring Expert Large Power Monitoring Expert
OS: Windows 8.1

Windows Server 2012 R2

DB: SQL Server 2014 Express

SQL Server 2014 Standard

Common Migrations types:
Migrate From (Power Monitoring Expert) Migrate To (Power Monitoring Expert)
Small Standalone System

Small Standalone System

Small Standalone System

Large Standalone System

Large Standalone System

Large Standalone System

Large Standalone System

Large Distributed System

Large Distributed System

Large Distributed System

If your situation does not exactly match any of the scenarios above, you can still use this document to help you with the migration process. Many of the steps are specific and do not vary
much between the different OS and DB systems. However, expect to spend extra time on
researching scenarios that might not be covered in this document. Extra risk may also be
involved as we did not test your particular migration scenario for this document.

Prerequisites
Before starting, take the time to plan the migration. Review this entire document to understand the procedures involved and the skills required to complete the tasks. Make sure you
have the necessary tools and information available at the time the tasks are performed. In particular, consider the following:
Make sure you have a copy of the SBS Upgrade Package that is distributed with
this document. This package contains tools to help you with the migration.
You need access to the PME 8.1 Install medium (DVD or .iso file).
You need Administrator privileges on both the old and the new computer.

© 2016 Schneider Electric. All rights reserved.
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You need Supervisor privileges for the old SPM system and PME 8.1 systems.
Both systems must be in the same language. You cannot change the
PME language during an upgrade.
The old SPM system must be in a functional state.
Review the IT Infrastructure Preparation for StruxureWare™ Guide.
This guide is written for IT administrators to help them prepare their IT system for an
upcoming installation of the PME software. The guide explains the system prerequisites needed to enable a successful installation and commissioning of the
software. Example prerequisites include Windows account creation and server
ports.
The new PME 8.1 system must be installed on a different computer and must be in
a functional state.
Custom report packs must be upgraded to be compatible on the new PME 8.1 system. If you transfer non-upgraded report packs to the new system, you will not be
able to use any reports. See "Troubleshooting Reports" on page 91 for more information.
The licensing system has changed from previous releases. The new PME 8.1 system includes a 90-day trial license for all features of the product. You must activate
all valid purchased software licenses within 90 days, or some software functionality
is disabled. Custom Reports or configuration tools that have been previously purchased with a license might require a license upgrade to continue using them after
the upgrade. See "License the New System" on page 23 for more information.

Note: For details on how to install PME 8.1, refer to the Power Monitoring Expert 8.1
Installation Guide that is delivered with the software.

Custom Report Packs
A custom report pack contains one or more custom reports that are not part of the default
PME software. Report customization can range from simple – such as adding custom
images – to advanced; relying on complex folder structures or requiring DLLs that were compiled using older versions of the .NET framework.
Because of these variations, custom report packs must be upgraded to be compatible on the
new PME 8.1 system.
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If the old custom reports have been upgraded to be compatible with PME 8.1, follow the
instructions in this guide to install the report packs to the new system. All reports, custom
and default, will work as expected.

IMPORTANT! If you transfer saved custom reports that were not upgraded to the
new system, you will not be able to use ANY reports in the new system; including the
default reports.
See "Troubleshooting Reports" on page 91 for information on using non-upgraded custom
report packs.

Competencies
To maximize your chance of successfully completing the tasks described in this document,
you should:
Be familiar with the StruxureWare Power Monitoring 7.0.1 and PME 8.1 software
products.
Have some experience running scripts in SQL Server Management Studio, and attaching,
detaching, and restoring SQL databases.
Be familiar with the Windows Operating System.
Have some experience editing the Windows System Registry.
Know how to stop and start Services in the Windows Services application.
Know how to run command line tools at a DOS command prompt.
Know how to restart Internet Information Services (IIS) using IIS Manager.

Estimated Upgrade Time
Section

Estimated Time

Introduction

20 minutes

Step 1 – Prepare both systems

60 minutes (+ possible troubleshooting time)

Step 2 – Copy the configuration of
the old system

30 minutes + 1.5 min/GB database size (ION_Data,
ION_Network, ApplicationModules, Archives)

Step 3 – Identify Settings that
must be Individually Transferred

30 minutes

© 2016 Schneider Electric. All rights reserved.
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Section

Estimated Time

Step 4 – Transfer the Configuration into the New System

60 minutes

Step 5 – Upgrade the Transferred
Configuration

150 minutes + 4 min/GB database size (ION_Data,
ION_Network, ApplicationModules, Archives)

Step 6 – Configure the Individually Transferred Settings

90 minutes (+ possible troubleshooting time)

Step 7 – Perform a Post-upgrade
System Check

60 minutes (+ possible troubleshooting time)

Total upgrade time* = 500 minutes (8.33 hours)
* Does not including database transfer or possible troubleshooting time.

Glossary
Certain acronyms, abbreviations, and technical terms are used throughout this document and
are defined in the table below.
Term
Database
Server

Description
A computer in a distributed PME system that is running the SQL database
server software and the PME databases.
See “Distributed System” for more details.

DB

Database (e.g., SQL Server 2008 R2).

DC

Data Center

Device

A meter or a point of data collection.

Distributed
System

A PME installation where parts of the system are installed on different computers. Several combinations are possible, but the most common is the separation of the PME applications and the Database server onto different
computers.
For example, a simple distributed install would have all the PME relevant programs and services installed on one computer and SQL Server with the PME
databases installed on a second computer. In this case, the computer running
the applications is called the Primary server, and the computer running SQL
Server is called the Database server.
A distributed system can also have Web client computers that run Web
browsers to view the PME Web applications such as Dashboards, Tables,
Alarm Viewer, and Reports inside the Web framework.
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Term
Download
able
Devices

Description
Standard Edition (SE) – Full support including logs etc; may be released as
an installer but will become native in the subsequent release of PME.
Limited Edition (LE) – Only real-time and PC based logging; created and supported by Schneider Electric; will never become native.
Custom Edition (CE) – Only real-time and PC based logging; created by Schneider Electric or 3rd party. CEs are used on an as-is basis; they were previously referred to as L2 or Jenny Type device drivers.
SE and LE drivers are available in the download area and can be released as
dPacks.
CE drivers are available on the Marketplace as-is.

ENM

Event Notification Module

HC

Healthcare

IIS

Internet Information Services

OS

Operating System

PME

Power Monitoring Expert

Primary
Server

Computer in a distributed PME system that is running all of the
PME applications and services. See “Distributed System” for more details.

SSDT

SQL Server Data Tools

SSMS

SQL Server Management Studio

Standalone A single computer running all parts of a PME system. See “Standalone SysServer
tem” for more details.
Standalone A PME installation where all parts of the system are installed on the same
System
computer, i.e., all applications and services, the SQL database server, and
the databases are on a single computer. This single computer is then referred
to as Standalone Server.
A standalone system can also have Web client computers which are running
Web browsers to view the PME Web applications like Dashboard, Tables,
Alarm Viewer, and Reports inside the Web framework.
VM

Virtual Machine (as compared to a physical computer).

Web Client

A computer in a PME system that runs a Web browser to view the Web
applications like Dashboard, Tables, Alarm Viewer, and Reports inside the
Web framework.
Both standalone and distributed PME systems can have Web clients.

© 2016 Schneider Electric. All rights reserved.
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Upgrade Process
Note: Due to modifications in PME, the side-by-side upgrade process has changed
since the previous PME release.

Each field deployed system is unique. Some systems have been modified very little from the
factory defaults, while others may have been completely customized. In PME, the various
configuration items and settings are stored in different locations and in different formats. Most
of the configuration items and settings stored in a file or in the database are easy to migrate in
bulk to the new system; however, a few must be recreated individually in the new system.
The upgrading of the configuration from the old system to the new system is accomplished in
seven steps and must be done in the following order:
"Step 1 – Prepare both Systems" on page 22
"Step 2 – Copy the Configuration of the Old System" on page 27
"Step 3 – Identify Settings that must be Individually Transferred" on page 34
"Step 4 – Transfer the Configuration into the New System" on page 37
"Step 5 – Upgrade the Transferred Configuration" on page 51
"Step 6 – Configure the Individually Transferred Settings" on page 71
"Step 7 – Perform a Post-upgrade System Check" on page 82
The detailed steps to upgrade the configuration are covered in this section.

Note: The old SPM system can keep running while the configuration is upgraded.
However, you might experience some performance degradation if two systems are
working with the devices.

Note: The procedural steps covered in this document do not include configuring new
features in PME 8.1.

© 2016 Schneider Electric. All rights reserved.
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Step 1 – Prepare both Systems
Before starting the upgrade process, it is important to understand the operational state of both
the old and the new systems.

Assess the Old System
Assess the old system by completing the following procedures:
1. Review the old SPM system to see if Devices, Vista Diagrams, Reports, and any
other configurations are working as expected.
2. Check the system log for errors. Correct any items in error or note them down so
you can address them on the new system after the migration.
3. Check the size of the historical data database (ION_Data) and look for database
archives that need to be migrated.
4. Consider trimming or emptying the PQ_Events table from the ION_Data table; this
can always be rebuilt if needed. This table can get quite large and might not be
needed on the new system.
5. Check the size of other tables and databases and consider what is needed in the
new system. Upgrading these tables can take a very long time if there are large
amounts of data being transferred and upgraded. Trim large databases to avoid long
upgrade times.
6. Determine whether the old report packs have been upgraded to work on the new system. See "Custom Report Packs" on page 16 and "Troubleshooting Reports" on
page 91 for more information.
7. Run the Diagnostic Tool that is found at ...\[Install location]\Schneider Electric\ION Enterprise\Power Software Diagnostics
Tool\Power Software Diagnostics Tool.ex
The Diagnostics Tool output provides a snapshot of the current state of the system. Reviewing this helps in identifying current or potential issues. It is advised that you select all the commands to run to get a full view of this system. Unzip the files (if compressed) and open the
HTML page by clicking on index.html for an overview of the results. Fix any issues as
needed before upgrading.
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Note: The migration of the ION_Data database is often the most time consuming
part of the system migration. You can expect this process to take about 1 hour for
each 15 GB in database size. It is often better to trim the database or archive portions
that are no longer needed before the migration. This is especially important for large
database sizes. Plan this part of the migration carefully.

Assess the New System
Note: The procedures in this document are based on the assumption that PME 8.1 is
installed correctly on the new computer, and that it is in a factory default configured
state. Any custom configuration that exists on the new system will be overwritten by
the migration procedures in this document.

Assess the new system by completing the following procedures:
1. Check a few of the basic functions such as the system log for errors, and inspect
the System Configuration Report.
2. Open the Web Application and ensure that there are no Dashboards and that the
default Web Reports are available.
3. Run the Diagnostic Tool that is found at ...\[Install location]\Schneider ElectricPower Monitoring Expert\Diagnostics Tool\Diagnostics Tool.exe
After confirming the installation is working correctly, assess whether the new system has
enough available hard disk space to accommodate the PME databases and the database
upgrade procedures.

Note: You should have at least four times the size of the PME databases in free hard
disk space to allow for: backups, disk usage during the database upgrade process,
and increase in the database size after the upgrade.

License the New System
The installed software includes a 90-day trial license for all features of the product. You must
activate valid purchased software licenses within 90 days, or some software functionality is
disabled.
For information on licensing, refer to the Power Monitoring Expert 8.1 Installation Guide. To
find to the installation guide, open the Management Console > click Help > Installation
Guide.

© 2016 Schneider Electric. All rights reserved.
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For quick answers to the most common licensing questions, refer to the PME Licensing
Guide. (You will need to provide your PME Exchange Community login credentials.)
Refer to the online help in Schneider Electric Floating License Manager for additional information.
Contact the Software Registration Center if you experience any problems activating your software licenses. Click Help > Support in Schneider Electric Floating License Manager for the
contact information.

Prepare the Side-by-side Upgrade Package
The Side-by-Side (SBS) Upgrade Package contains upgrade tools and a folder structure to
help you organize and prepare both systems for upgrade.
In subsequent steps you will copy configuration files from the old system to SBS Upgrade
Package folders, use the tools to facilitate the upgrade, and then copy the entire
SBS Upgrade Package to the new system.
To prepare the SBS Upgrade Package:
Locate the SBS Upgrade Package and copy it to the C:\ drive of the old system.

Distributed System Note: If the old SPM system is a distributed system, copy the
SBS Upgrade Package on the Primary and the Database Server in the following manner:

On the Primary Server:
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On the Database Server:

At this point, the following folders are empty:
\config
\Custom_Reports
\Dashboard_Images
\Data_Center_Images
\Database_Archives
\Database_Backups
\EWS
\Report_Subscription contains the following files:
ExportSubscriptions.exe
gacutil.exe
ImportSubscriptions.exe
IONSubscriptionsHelper.dll
\SQL_Script_Files contains the following files:
Fix_PME_Users.sql
SSDT_cmd_Line.bat

© 2016 Schneider Electric. All rights reserved.

Page 25 of 100

Upgrade Process

update_server_name_in_archive_databases.sql
update_server_name_in_live_databases.sql
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Step 2 – Copy the Configuration of the Old System
After assessing the old and new systems and ensuring they are operating properly, copy the
old SPM system configuration components to the SBS Upgrade Package.

Copy Database Backups and Archives
The database backups from the old system need to be copied to the SBS Upgrade Package.
The following databases from the old system must be backed up:
ION_Data (contains the historical data and event logs)
ION_Network (contains the configuration information)
ApplicationModules (contains the Web application related information)

Note: Do not copy a backup of the System Log database; it contains information relevant to the old SPM system. The new system has its own System Event log.

Distributed System Note: The databases and archives are located on the Database
Server.

To back up the system databases and database archives:
1. Open SQL Server Management Studio and connect to the SPM database instance.
Note: You can find the location of the database files by viewing the Properties
of the database in SQL Server Management Studio.
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2. Right-click the ION_Data database and then click Tasks > Back Up.

3. Name the backup file ION_Data and back it up to the ...\SBS Upgrade Package\Database_Backups folder.

© 2016 Schneider Electric. All rights reserved.
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Note: You can expect this backup process to take about 15 minutes for a 10 GB database.

4. Repeat this process for both the ION_Network and ApplicationModules databases.
Use ION_Network and ApplicationModules as the label names for the backup files.
Repeat this process to backup the database archives from the old system, using the name of
the archive as the name for the backup. Copy them to the ...\SBS Upgrade Package\Database_Archives folder.

Copy config Folder
The config folder contains many of the system configurations in the old SPM system.
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However, the following …\Schneider Electric\ION Enterprise\config files and
folders are not needed for the migration and should not be copied:
The DatabaseRegistry.reg file
The \config\cfg\DBBackups and \config\cfg\Archives folders. This is
where scheduled database backup and archive files are stored. These files tend to
be large and since we copied the archive files separately, there is no need to copy
them again.
Any other database backups or archive files that might be stored in \config or any of
its sub-folders.
The PowerShell scripts in …\Schneider
Electric\ION Enterprise\config\cfg\DbScheduledTasks.
Copy the remaining content of the \config folder on the old system to the ...\SBS
Upgrade Package\config folder.

Distributed System Note: There is a ...\config folder on both the Primary
Server and the Database Server:
1. Copy the \config folder on the Primary Server into the ...\SBS Upgrade
Package\config folder you created for the Primary Server.
2. Copy the \config folder on the Database Server into the ...\SBS Upgrade
Package\config folder you previously created for the Database Server.

Custom Report Packs
The old system might contain custom report packs. These must be updated before you can
use them on the new system.

IMPORTANT! Some custom report packs may not upgrade correctly due to missing
the file Content_Types.xml and other modifications. Contact the provider of the
custom report pack BEFORE upgrading to PME 8.1 and ensure its functionality has
been tested on PME 8.1. See "Custom Report Packs" on page 16 and "Troubleshooting Reports" on page 91 for more information.
To check the old system for custom report packs:
1. Navigate to …\Schneider Electric\ION Enterprise\web\ReportPacks\
2. Identify any custom report packs that exist on the old system.
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3. Contact the report pack provider to obtain a PME 8.1 compatible version of these
report packs.

Copy Report Subscriptions
The SBS Upgrade Package includes a tool that copies the old system report subscriptions.
However, since report subscriptions in SPM are handled differently depending on which SQL
Server edition is used, the tool does not work for certain SQL server edition upgrade scenarios.
SQL Server
Edition

Scheduling
Tool

Configuration UI

Schedule Details

SQL Standard SQL Agent

Report Management UI in
Web Applications

Stored in msdb database
(part of SQL Server)

SQL Express

Report Management UI in
Web Applications

Stored in ION_Network database

ION Task
Scheduler

Use the following information to determine which upgrade process to use:
SPM 7.0.1

PME 8.1

Upgrade Process

SQL Standard SQL Standard Use SBS Upgrade Package tool (see instructions below)
SQL Express

SQL Standard Use SBS Upgrade Package tool (see instructions below)

SQL Standard SQL Express

Subscriptions must be recreated in PME (skip this topic)

SQL Express

Subscriptions are automatically transferred with the ION_
Network database migration (skip this topic)

SQL Express

Distributed System Note: Complete these tasks on the Primary Server.

To copy the report subscriptions:
1. In the ...\SBS Upgrade Package\Report_Subscriptions folder, locate
ExportSubscriptions.exe and IONSubscriptionsHelper.dll.
2. Copy the 2 files to the ...\ION Enterprise\system\bin folder on the old
StruxureWare Power Monitoring system.
3. As the Administrator, run ExportSubscriptions.exe.
The tool opens a command prompt and indicates when the task is complete.
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The output of the tool is a file called ...\ION
Enterprise\system\bin\IONSubscriptionData.xml.
4. Press Enter to close the command prompt window.
5. Copy IONSubscriptionData.xml to the ...\SBS Upgrade Package\Report_Subscriptions\ folder.

© 2016 Schneider Electric. All rights reserved.
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Step 3 – Identify Settings that must be Individually
Transferred
The previous step resulted in copying configuration settings, such as the ...\config folder
or the databases, to easily transferable locations.
For this section, examine the existing system for customizations that need to be individually
transferred and then decide which of these are needed on the new system.

Scheduled Tasks on the Old System
Any scheduled tasks that exist on the old system need to be manually recreated on the new
system if desired. See "Scheduled Jobs in Database Manager" in StruxureWare Power Monitoring help for more information on how to check for scheduled tasks.

OPC Measurement Definitions
SPM ships with a factory default file that defines which measurements are available for the
different device types through OLE for Process Control (OPC).
It is possible to edit this file to add new device types and measurements. Changes made to
the existing OPC measurement definition file need to be manually copied to the new system.
To check OPC Measurement Definitions for changes:
1. Navigate to the ...\Schneider Electric\ION Enterprise\system\IONServices folder.
2. Open DefaultMeasurements.xml.
3. Check the file and then note the changes that you want to recreate on the new system.

Registry Settings
Some functions in SPM and PME are controlled by settings that are stored in the Windows
registry. Most of these settings – also called registry keys – are part of the default system
install and do not need to be transferred. However, some registry keys might have been
added after the install and transferred to the new system.
The most common custom registry keys are for:
Specifying a custom network diagram (instead of using the default network diagram)
to be used in the Diagrams (WebReach) part of the Web Applications.
Enabling linking of custom device types (for example, those created with the MDI)
to default diagrams in ION Vista.
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This topic outlines how to:
Export the entire set of SPM registry keys to a text file as a backup in case this
information is needed in the future.
Locate for specific keys that are commonly added and that will have to be recreated
on the new system.
To copy the custom registry settings:
1. Start the Windows Registry Editor.
2. Navigate to the default location for StruxureWare Power Monitoring
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider Electric
[for 64-bit systems]
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric [for 32-bit systems]
3. Right-click Schneider Electric and export the registry as a TXT file.
4. Copy the TXT file into ...\SBS Upgrade Package\
To find a customized network diagram key:
1. Open the Windows Registry Editor and browse to:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider
Electric\ION Enterprise\7.0.1\WebReach [For 64-bit systems].
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider
Electric\ION Enterprise\7.0.1\WebReach [For 32-bit systems].
2. Search for a key named NetworkDiagram.
3. Write down the value of this key; it will look like a file path. For example: x-pml:/diagrams/ud/campus/campus_home.dgm
To find a custom device type key used for Vista diagram linking:
1. Open the Windows Registry Editor and browse to:
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider
Electric\ION Enterprise\7.0.1\DeviceInfo [For 64-bit systems].
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider
Electric\ION Enterprise\7.0.1\DeviceInfo [For 32-bit systems].
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Page 35 of 100

Upgrade Process

2. Compare the list of device types to the list of "Default Device Drivers" on page 84.
3. Write down the custom keys and values or export that section of the registry.

ION Login Password
The Modify Login action in Database Manager changes the SQL Server password for the
default login name ION.
To check whether the password has changed:
1. Open the Windows Registry Editor and browse to:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider
Electric\ION Enterprise\7.0.1\Databases [For 64-bit systems]
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric\ION
Enterprise\7.0.1\Databases [For 32-bit systems]
If there is a key named Password, of Type REG_BINARY, then the ION login has been
changed. You will need to find the password and manually change it using the Database Manager tool on the new system.
If there is no such key, then the default password is used and no changes need to be made on
the new system.

Dashboard Images
To copy the dashboard images from the old system:
1. In Windows Explorer navigate to ...\Schneider
Electric\ION Enterprise\Applications\ApplicationFramework
\BackgroundImages.
2. Copy the image files ...\SBS Upgrade Package\Dashboard_Images.
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Step 4 – Transfer the Configuration into the New System
The topics in this section outline how to transfer the configurations from the old SPM system
into the new PME 8.1 system.

Prepare the New System
On the new system, prepare for transferring the configuration by completing the following
steps:

Distributed System Note: Stop the services on the Primary Server.

1. Close all applications and use the Windows Services application to stop the following services on the Primary Server (there are no services running on the Database Server):
ApplicationModules AlarmServiceHost
ApplicationModules CoreServicesHost
ApplicationModules DataServicesHost
ApplicationModules ProviderEngineHost
ION Alert Monitor
ION Component Identifier Service
ION Connection Management Service
ION Event Watcher Service
ION Log Inserter Service * (Disable the ION Log Inserter Service after stopping it. See * below.)
ION Managed Circuit Service
ION Network Router Service
ION OPC Data Access Server
ION PQDIF Exporter Service
ION Query Service
ION Real Time Data Service
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ION Report Subscription Service
ION Site Service
ION Software Alarm Service
ION Software Modbus Gateway Service
ION Virtual Processor Service
ION Virtual Processor Service -NVIP.PQADVISOR
ION XML Subscription Service
ION XML Subscription Store Service
IMPORTANT NOTES:
* If this service starts accidentally before all changes are made, the database may
become inoperable, a state from which it is difficult to recover.
Ensure all services are stopped before proceeding.
Some services may have Startup Type set to Manual and may not be running.
ION services automatically restart when the computer is rebooted.
Until the installer automatically starts all the necessary ION services as part of the
upgrade configuration, the ION services must remain stopped.

Copy the SBS Upgrade Package to the New System
The SBS Upgrade Package must be copied to the new computer; for example by using a
removable drive to transfer the files.
Copy the ...\SBS Upgrade Package folder and all its sub-folders to the C: Drive of the
new computer.

Distributed System Note: Copy the Database folders to the Database Server.
Copy the remaining folders to the Primary Server.

Transfer config Folder
Copy the entire ...\SBS Upgrade Package\config folder and its contents to the
…\Schneider Electric\Power Monitoring Expert\config location on the new
system, overwriting any existing folders and files.
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Distributed System Note: For situations involving distributed installs of PME, do
one of the following:

Old System Type

New System Type

Distributed

Distributed

Standalone Distributed

Import Steps
Copy the ...\SBS Upgrade Package\config folder from
the Primary Server to the new PME Primary Server. Copy
the...\SBS Upgrade Package\config folder from the
Database Server to the new PME Database Server.
Copy the ...\SBS Upgrade Package\config folder to
the Primary Server as described above.
For the Database Server, copy the following ...\SBS
Upgrade Package\config sub-folders to the ...\Schneider Electric\Power Monitoring Expert\config folder on the Database Server:
\AlertMonitor
\diagrams
\exporters
\lvp
\reports
\templates
\translators

Distributed

Standalone Copy the ...\SBS Upgrade Package\config folder from
the Primary Server and the Database Server to the new PME
standalone server.

Transfer Dashboard Images
To transfer the dashboard images:
1. Copy the image files from ...\SBS Upgrade Package\Dashboard_Images to
...\Schneider Electric\Power Monitoring Expert\Applications\SystemDataService\App_Data\Images\BackgroundImages.

Note: Do NOT overwrite files in the target folder.

© 2016 Schneider Electric. All rights reserved.
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Connect the Old Databases
You need to remove, rename, or delete the factory (new) database files before you can connect the old databases to the new system.

Distributed System Note: Complete these steps on the Database Server.

Detach the Default Databases
Before you can remove, rename, or delete the factory installed ION_Data, ION_Network, and
ApplicationModules databases on the new system with the copies made from the old SPM
system, you must first detach the factory installed databases.
To detach the ION_Data database from the new system:
1. Go to SQL Server Management Studio and right-click ION_Data > Tasks > Detach.
Note: If you cannot detach a database because of active connections, select
the Drop Connections option in the detach dialog in SQL Server Management
Studio. For example:

2. Follow the same steps to detach the ION_Network and ApplicationModules
databases.

Remove, Rename, or Delete the Factory Databases
Detaching the databases will not remove the database files from the new folder structure.
Since the old databases that you need to upgrade must be in the same location as the factory
ones, you need to delete, remove, or rename the factory database files. The factory database
files are located at ...\Schneider Electric\Power Monitoring Expert\Database\ApplicationModules, \Data, \Network.
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1. Navigate to ...\Schneider Electric\Power Monitoring Expert\Database\ApplicationModules, \Data, \Network.
2. Rename the factory database files.
For example:

Restore the Databases from the Old System
Restore the old databases to the new system at their default location:
ION_Data database: …\Schneider Electric\Power Monitoring Expert\Database\Data
ION_Network database: …\Schneider Electric\Power Monitoring
Expert\Database\Network
ApplicationModules database: …\Schneider Electric\Power Monitoring
Expert\Database\ApplicationModules
To restore copies of the old SPM databases into the new PME system:
1. In SQL Server Management Studio, right-click Databases and then click Restore
Database.
2. Click Device and then click ... (the ellipsis button).

© 2016 Schneider Electric. All rights reserved.
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3. Click Add.

4. In the Locate Backup File dialog, navigate to the SPM database file from the ...\SBS
Upgrade Package\Database_Backups folder and enter the database name in
the File name field.
For example:

© 2016 Schneider Electric. All rights reserved.
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5. Click OK.
6. Make sure that Restore is checked:
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7. Click on the Files tab on the upper left of the window, click Relocate all files to
folder, and then select the location for restoring the database:

© 2016 Schneider Electric. All rights reserved.
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8. Select the default location for the PME databases. For example:

9. Click OK.
The following image shows the restored databases:

Page 46 of 100

© 2016 Schneider Electric. All rights reserved.

Upgrade Process

Note: You can expect the database restore to take about 5 minutes for a 10 GB database.

Restore the Archive Databases to the New System
Since the new PME system does not have a default folder location for database archives, create a folder called …\Schneider Electric\Power Monitoring Expert\Database\Archives.
Repeat steps 1 through 9 above, restoring the archive databases to this folder.
For example:

© 2016 Schneider Electric. All rights reserved.
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Import Custom Report Packs
Note: Upgrading custom reports is not within the scope of this SBS upgrade process. Contact your report provider to upgrade the old reports to PME 8.1. Once
upgraded, you can install them on the new PME system.

Importing the upgraded custom report packs into the new PME system is a 2 step process:
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1. Copy the upgraded report packs into the new system.
2. Install them on the new PME system.
You will complete the first step now; step two will be completed later.

Distributed System Note: Complete this step on the Primary Server.

To copy the report pack into the new system:
1. Copy all upgraded report packs to …\Schneider Electric\Power Monitoring Expert\Web\ReportPacks\.

Import Report Subscriptions
Since report subscriptions in SPM and PME 8.1 are handled differently depending on which
SQL Server edition is used, use the following information to determine which import process
to use:
SPM 7.0.1

PME 8.1

Import Process

SQL Standard SQL Standard Copy the SBS Upgrade Package report subscriptions to
the new system (see instructions below)
SQL Express

SQL Standard Copy the SBS Upgrade Package report subscriptions to
the new system (see instructions below)

SQL Standard SQL Express

Subscriptions must be recreated in PME 8.1 (skip this
topic)

SQL Express

Subscriptions are automatically transferred with the ION_
Network database migration (skip this topic)

SQL Express

Distributed System Note: Complete the following steps on the Primary Server.

To import the report subscriptions:
1. Copy the contents of the ...\SBS Upgrade Package\Report_Subscriptions\folder into the …\Schneider Electric\Power Monitoring
Expert\system\bin\ folder.
The report subscriptions will be installed in a subsequent step.
At this point, all of the old SPM configuration has been moved to the new system and is ready
to be upgraded and installed on the new system.
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IMPORTANT! The configuration is still NOT ready for use. More steps are required
to upgrade the configuration to make it compatible with the new system.
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Step 5 – Upgrade the Transferred Configuration
To upgrade the transferred configuration on the new system, complete the tasks in this section.

IMPORTANT! The new system is NOT in a functional state. You cannot start the services or run the applications. Make sure you follow the exact sequence provided
below. Whether done manually or by using the SQL script, the databases MUST be
upgraded before the server name changes are made.

Upgrade ION_Data, ION_Network, and archived databases
IMPORTANT! Make sure the new system has at least four times the size of the
PME databases in free hard disk space to allow for: backups, disk usage during the
database upgrade process, and increase in the database size after the upgrade.
Use the Database Manager tool in PME to upgrade the databases for ION_Data, ION_Network, and archive databases. Since the system is not yet functional, you cannot start Management Console to access the Database Manager. To open this tool, start
DatabaseManager.exe from the …\Schneider Electric\Power Monitoring
Expert\system\bin folder.

© 2016 Schneider Electric. All rights reserved.
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Distributed System Note: Complete these steps on the Database Server.

Note: Upgrading large databases is a time consuming process. Expect this to take
approximately one hour for each 15GB of database size. Also, the disk space
required for the upgrade can be as much as 4 times the size of the original database.
Make sure there is sufficient disk space for this upgrade.

IMPORTANT! Upgrade the ION_Data database first, before you upgrade the ION_
Network database or any other archived databases.
To upgrade the database:
1. In Database Manager, select Upgrade Databases.

2. Select ION_Data for upgrade.

ION_Data Upgrade is Complete

Page 52 of 100

© 2016 Schneider Electric. All rights reserved.

Upgrade Process

3. Repeat steps 1 and 2 to upgrade ION_Network and any archived databases.
The ApplicationModules database follows a different process. See the steps below to
upgrade this database.

Upgrade ApplicationModules Database
1. Navigate to the ...\SBS Upgrade Package\SQL_Script_Files folder and
use a text editor to open SSDT_cmd_Line.bat.
2. Before running the script, make the following changes to the file in this order:
a. In a text editor open SSDT_cmd_Line.bat, right-click and select
Edit.

b. Verify the Microsoft SQL Server path is correct. Edit the path if it is not
the following:
SET "PathToSqlPackage=Microsoft SQL Server\120\DAC\bin\sqlpackage.exe"
c. Verify that the SQL path and the SQL Instance are correct. Change if
different from the following:
The MDFPath and the LDFPath need to reflect the SQL
Version being used and the SQL Instance respectively,
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NOT the database path.
SQL 2008R2 will be MSSQL10_50.<SQL
Instance>\MSSQL\DATA
SQL 2012 will be MSSQL11.<SQL
Instance>\MSSQL\DATA
SQL 2014 will be MSSQL12.<SQL
Instance>\MSSQL\DATA
d. (Optional) If the PME system is not installed at the default file location,
edit the following parameter to match to the system’s exact file path:
SET PMEPath=C:\Program Files (x86)\Schneider Electric\Power Monitoring Expert
3. After saving the file, execute it by double-clicking on the file name.

After the above batch file is executed, close the prompt window. An ApplicationModules.sql file is created in the ...\SBS Upgrade Package.
4. Before running the ApplicationModules.sql file, enable the SQLCMD mode:
a. In SQL Server Management Studio click Tools > Options > Query
Execution > SQL Server > General.
b. Select By default, open new queries in SQLCMD mode, then click
OK.
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5. In SQL Server Management Studio open the ApplicationModules.sql file and
then click Execute to run the script.
6. After running the ApplicationModules.sql file, disable the SQLCMD mode:
a. In SQL Server Management Studio click Tools > Options > Query
Execution > SQL Server > General.
b. Uncheck By default, open new queries in SQLCMD mode, then
click OK.
7. Update the DataSourceSignature:
a. In SQL Management Studio, go to the ApplicationModules.DataSourceBus.DataSource table.
b. Right-click the table and select top 1000 rows.
c. Copy the Signature by right-clicking and selecting Copy.
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8. In a text editor open …\Schneider Electric\Power Monitoring Expert\Applications\bin\DataServicesHost.config and then update the
DataSourceSignature value to match the one you copied in the image above.

Note: Once the upgrade is complete, it is recommended that you make a backup of
the upgraded databases. Should your database become corrupted at a later time, this
backup of the upgraded databases will help you to complete the upgrade successfully. A suggested location for these backups is …\Schneider Electric\Power Monitoring Expert\config\cfg\DBBackups.

Update Server Name
Note: These steps are required only if the new server name is different from the old
one. If the names are the same, you can skip this section.
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Some applications in PME reference the name of the computer where the system resides.
Since the old name is embedded in the databases and configuration files of the old system, it
is transferred to the new system with this configuration. If the name of the new computer or
server is different from the old one, there is a mismatch.
The topics in this section describe how to remove this mismatch by updating the name stored
in the configuration to the new computer or server name.

Distributed System Note: Unless otherwise noted, complete these steps on the
Primary Server.

Locate and Note Server Name in Management Console
You will need to reference the new server name in subsequent tasks.
To find the name of the computer the PME 8.1 server is running on:
1. In Windows Server 2012 or later, right-click the Windows Start button and then
select System.
The computer name is displayed in the System dialog:

2. Note the computer name; you will need to reference it later.
To find the old server name that is currently configured in the transferred configuration:
1. Log in to the Management Console using the old system login credentials.
2. View the Servers panel.
For example:
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Note: Since the ION_Network database is now accessible, the Management Console can be opened.

3. Note the existing server name. You will need to reference it later.

Update Server Name in the Databases
Distributed System Note: Complete these steps on the Database Server.

To update the server name in the ION_Data and ION_Network databases:
1. Open SQL Server Management Studio, select File > Open File, then select the
update_server_name_in_live_databases.sql script in the ...\SBS
Upgrade Package\SQL_Script_Files folder.
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2. Edit the script to provide the old and new server names and the instance name.

3. Save the script and then click !Execute to update the server name in the databases.
4. Verify that the script worked by looking in ION_Data.dbo.Source table. The
LOGINSERTER source should now show the new server name.

Note: For any archived databases, complete steps 1 to 3 above, but use the
update_server_name_in_archive_databases.sql script instead. Repeat
these steps for each archived database.

Update Server Name for the VIP
When PME is installed, a factory default VIP is created. The configuration files and folder for
this VIP contain references to the server name. You need to replace the VIP that was created
during the new PME installation with the VIP from the old SPM system. This only addresses
the default VIP. Custom VIPs are addressed in a subsequent step.

Note: Do not modify the VIP. PQADVISOR. This is a new VIP that was introduced
in PME 8.1.

To update the server name for the VIP:
1. Find the old and new VIP folders in …\Schneider Electric\Power Monitoring Expert\config\cfg\vip.
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2. Copy vip.bak and vip.cfg from the old VIP folder (VIP.OLDSERVER in the
example) into the new one (VIP.NEWSERVER in the example), overwriting the
files, and then delete the old folder.
This transfers the configuration of the default VIP from the old system into the new
system.
3. Find the node diagram for the VIP in …\Schneider Electric\Power Monitoring Expert\config\diagrams\nd, delete the new node diagram, if one
exists, and rename the old one to match the new server name. Not every system
will have this \nd configured with the VIP.
4. If they exist, delete all the VIP tree files, new and old, in …\Schneider Electric\Power Monitoring Expert\config\trees.

Update Server Name for other Components
The names for files related to the Diagnostics and the Designer node diagrams need to be
updated.

Note: The \nd folder will not be on your system if it has not been configured. Skip
this step if nothing is there.
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Distributed System Note: Complete these steps on the Primary Server and on the
Database Server (for those files that exist on the DB server).

To update the server name for other components:
1. Delete the old server Diagnostics Configuration file in …\Schneider Electric\Power Monitoring Expert\config\Diagnostic\.

2. Rename or delete the old Query Server and Log Inserter Designer files if any are
present in …\Schneider Electric\Power Monitoring Expert\config\diagrams\nd\. Only the new server name files are needed.

Update Server Name for Alert Monitor
The Alert Monitor configuration file includes the server name. If the Alert Monitor configuration
file was configured in the old system, replace the {Old Server Name} with the {New Server
Name}.
To update the Alert Monitor configuration file name:
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1. In Windows Explorer navigate to ...\Schneider Electric\Power Monitoring Expert\config\AlertMonitor.
2. If a {Old Server Name}.AlertMonitor.config file exists, rename it with the
name of the new server.(Do NOT delete the {MachineName}.AlertMonitor.config template.)

Delete old Log Inserter and Query Server Folders
The Log Inserter and the Query Server in PME store configuration information in folders and
files that reference the existing system's server name. These folders and files must be
deleted for the old configurations.

Note: A backup file might be present depending on the customizations done to the
Log Inserter or Query Server. If there is a customized Log Inserter or Query Server,
consult Technical Support for instructions on how to migrate them to the new system.

To delete the old configuration files:
1. Navigate to the Log Inserter and Query Server configuration folders in …\Schneider Electric\Power Monitoring Expert\config\cfg\logsrv.
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2. Delete the older server folders.

Register Custom VIPs
If the old SPM system contained custom VIPs, then you need to register them in the new system before they can be used. The configuration folders and files for these VIPs were transferred as part of the \config folder transfer.

Distributed System Note: Complete the following steps on the Primary Server.

To determine if there are custom VIPs:
1. Navigate to …\Schneider Electric\Power Monitoring Expert\config\cfg\vip
If there are custom VIPs in this folder, they need to be registered on the new system.
To register custom VIPs:
1. Open a command prompt as the Administrator.
2. Change to the …\Schneider Electric\Power Monitoring Expert\system\bin folder.
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3. Run vip.exe –Service –N<custom VIP name>.
The new service is added for the custom VIP.

Note: The VIP name service registration is case sensitive; make sure you spell it
exactly as it was in the old SPM system.

Install the Report Subscriptions
Installing the report subscriptions depends on the SQL Server Editions used by the old and
new systems:
SPM 7.0.1
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SQL Standard

SQL Standard

Use the SBS Upgrade Package tool (see
instructions below)

SQL Express

SQL Standard

Use the SBS Upgrade Package tool (see
instructions below)

SQL Standard

SQL Express

Subscriptions must be recreated in PME 8.1
(skip this topic)

SQL Express

SQL Express

Subscriptions are automatically transferred
with the ION_Network database migration
(skip this topic)
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Distributed System Note: Complete these steps on the Primary Server.

To install the Report Subscriptions:
1. Navigate to …\Schneider Electric\Power Monitoring Expert\system\bin folder and then run ImportSubscriptions.exe.
2. In the dialog box that opens, make sure the file path is …\Schneider Electric\Power Monitoring Expert\system\bin\IONSubscriptionData.xml:

3. Click Import Subscriptions.
When the import is complete, a Successfully Imported Subscriptions dialog is displayed.

Update SQL Server Logins
To update the SQL Server logins:
1. In SQL Server Management Studio, navigate to the ...\SBS Upgrade Package\SQL_Script_Files folder.
2. Using a text editor, open Fix_PME_Users.sql.
3. Replace <NEW_PME_SERVERNAME> with the name of the server on the new system:
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4. Save the script file and then execute it.

Update SQL Server name for PQDIF reports
For server configurations that contain PQDIF Reports in Reporter:
1. Find and edit the PQDIFExporterConfig.xml configuration file in the …\Schneider Electric\Power Monitoring Expert\config\exporters\PQDIF\config folder.
2. Update the SQLServer Name and Password. The SQLServer name should match the
new server name, and the password should match that of the RepGen reports; see
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"Update RepGen Report Parameters" on page 75.

Note: If there is nothing configured for PQDIF then these values will be blank (“”).

Reconfigure PME 8.1
The PME 8.1 Installer is used to upgrade additional configuration files. Access to the PME
8.1 Install medium (DVD or .iso file) is required for this step.

Note: Upon completion of the steps below, the “supervisor” account password is
reset to the password that was specified when PME 8.1 was first installed. It will not
be the same as it was on the old SPM system. Use the User Manager application
that is accessed via the Management Console to change the password if needed.

Distributed System Note: Complete the following steps on the Database Server
first, and then on the Primary Server.

To update the configuration files:
1. Close any PME programs that may be running.
2. Change the ION Log Inserter service back to Automatic. It was previously disabled.
3. Run the PME 8.1 installer or the MainSetup.exe.
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4. Choose Configure to upgrade the configuration.

5. Once the configuration is successfully complete, click Next to complete the reconfiguration.

Note: The PME Installer will start all necessary ION Services as part of the configuration upgrade. Any Custom VIP service configured must be started manually.
Start the ION Services using the administrative credentials.

Install Custom Web Report Packs
In an earlier step, the PME 8.1 compatible custom web report packs were copied into …\Schneider Electric\Power Monitoring Expert\Web\ReportPacks on the new
PME system. They need to be installed on the new system.

Distributed System Note: Complete the following steps on the Primary Server.

To install the report packs:
1. The Report Pack should be available in the Reports application. If not, then open
Web Applications > Reports. In the Report Library section in the right pane, use
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the tools provided to upload the report pack.

Note: The reports list in the Report Library may be empty until the custom
reports have been installed.

2. Select the report packs to install and then click Install.
For example:
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System Reboot
At this point in the upgrade process, many configuration changes are complete, and it is
recommended that you reboot the system.
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Step 6 – Configure the Individually Transferred Settings
These steps adjust those settings and configuration items that are not part of the
SBS Upgrade Package transfer.

Scheduled Tasks
PME 8.1 uses Microsoft Windows Task Scheduler to schedule database maintenance jobs
such as archiving or backup. Details of the default PME database maintenance jobs are
defined in a number of PowerShell scripts.
Compare the default settings on the new system to the ones noted from the old system.
Decide which settings should apply to the new system and encode them into these script
files.

To review the PowerShell script settings:
1. In Windows Explorer navigate to …\config\cfg\DbScheduledTasks\Support and open Configuration.ps1.
2. Note the setting values for:
$locationForBackupFiles
$maximumDatabaseSizeInGigabytes
$databaseSizeNotificationThresholdPercentage
$diagnosticsDaysToKeep
3. Navigate to …\config\cfg\DbScheduledTasks\ and open Backup.ps1.
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4. Note the setting values for:
$numberOfBackupsToRetain
5. Compare these settings to the ones noted from the old system. Decide which settings should apply to the new system and encode them into these script files. If in
doubt, use the default settings on the new system.

Vista Diagram Links
Because the Query Server name includes the computer name, which has changed from the
old system to the new, any Vista diagrams that use Custom Query Server links must be
updated. Updating the Custom Query Server links can be done manually by opening the diagram and changing the Query Server link of the diagram background.
If inheritance is used in the Vista diagram, then only the top most diagram needs to have its
Query Server link updated. The update filters down into any linked diagrams.

However, for a large number of diagrams, use a search and replace tool that can find the
Query Server strings in the diagram files and update them to the new server name.
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Note: Search for the Query Server string settings where the use_parent link option
is set to 0. There are many server references in each Vista diagram that have a use_
parent link set to 1; you can ignore these.

The same is true for any links in the diagrams (for example, a numeric value) to the VIP(s)
that were migrated from the old system to the new. The name of the VIP might reference the
computer name, and if this name has changed, then the links to the VIPs must be updated.
If you encounter issues, see "Device Diagram Customizations" on page 97 in the
Troubleshooting section.

OPC Measurement Definitions
Update the DefaultMeasurements.xml file with the changes identified in "OPC Measurement Definitions" on page 34.

Note: If you simply copy the old file into the new system, you overwrite any new additions to the file that are part of the new system. This might be acceptable or not,
depending on if you need the device types and measurements that have been added.
In general, it is a better practice to keep the new file and manually add any customizations.

Web Report Subscription Parameters
Since the system was moved from one computer to another, it is possible that file paths that
were previously configured for saving reports as part of a subscription need to be changed.
To update these file paths:
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1. Open the Manage Reports in the Reports Web Application.

2. Click Subscribe and then Modify.
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3. Select the File share option and enter the Report destination path.

Note: The Windows IONUser account needs write permission to the folder
where the report is being delivered.

4. Click Save.

Update RepGen Report Parameters
The SQL Server report login password for SPM may be different from PME 8.1. Any saved
reports that were brought forward from the old system will contain the old password and need
to be updated.
To find the new password:
1. On the new system, navigate to the …\Schneider Electric\Power Monitoring Expert\system\reports folder.
2. Open one of the default report template files. For example, Load_Profile.xls.
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3. Search for the PASSWORD field that contains the new password.
Use this password to update the old saved reports.
The password needs to be updated in two places for each report: in the Reporter and the
Excel workbook.
To update the password in Reporter:
1. Open Reporter, select a report, and click Edit.

2. On the Sources tab, click More in the database field.
3. Update the password in the dialog that opens:
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To update the password in the Excel workbook:
1. Open a report workbook from the …\Schneider Electric\Power Monitoring Expert\config\reports folder.
2. Right-click any tab and then unhide the |PRIVATE|Datasheets.
3. Update the password to the new PME password. Also change the server name on
the far right end of the entries in this sheet to the new server name. Repeat this step
for all the Excel reports in the Reports directory.
If a report is configured to be saved to disk (instead of shown on screen only), you need to
update the report and re-save it in the new PME location before you generate any saved
reports.
To update a report:
1. Open Reporter and click the radio button for Manage Reports.
2. Highlight a report and click Edit.
3. Click the Distribution tab.
4. Verify that the Save Excel report folder path is correct or create a new one.
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5. Click OK.
6. Click the radio button for Generate Reports and then generate the report to verify it
is working properly.

Registry Settings
Editing the registry entries in the new system is necessary if you want to:
Specify a custom network diagram (instead of using the default network diagram) to
be used in the Diagrams (WebReach) part of the Web Applications.
Enable linking of custom device types (for example, those created with the MDI) to
default diagrams in ION Vista.
Do NOT import any performance tuning settings from the old ION Enterprise. The default settings in PME 8.1 have been optimized for that system and should only be changed by experts
with a deep understanding of the ramifications of the changes.
To customize the network diagram:
1. Start the Windows Registry Editor and browse to:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider Electric\Power Monitoring Expert\8.1\WebReach [For 64-bit systems]
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric\Power Monitoring Expert\8.1\WebReach [For 32-bit systems]
2. Right-click to Add a new string value of NetworkDiagram.
3. Right-click NetworkDiagram, select Modify, and type the path and name of your
custom network diagram in the Value data field.
For example: x-pml:/diagrams/ud/<custom folder>/<custom diagram>.dgm.
4. Restart IIS on the system to apply the changes.
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To enable the diagram linking in Vista:
1. Start the Windows Registry Editor and browse to:
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Schneider Electric\Power Monitoring Expert\8.1\DeviceInfo [For 64-bit systems]
HKEY_LOCAL_MACHINE\SOFTWARE\Schneider Electric\Power Monitoring Expert\8.1\DeviceInfo [For 32-bit systems]
2. Add the necessary entries for the custom device types.

ION Login Password
The Modify Login action in the Database Manager tool changes the SQL Server password for
the default login name ION. If the password was changed on the old system, it needs to be
manually changed to the same string on the new system in the PME Database Manager.
To change the password:
1. Stop all PME services.
2. From the Management Console start Database Manager.
3. Right-click Databases then select Modify Login to open the Modify Login dialog.
4. Type the new password in the New Password and Confirm New Password fields.
Click OK.
5. Restart the services.
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Clear Browser Cache
Following an upgrade, it is recommended that you:
1. Delete the browser cache.
This will clear any old configurations or cached pages that might have been on the
system before the upgrade. If you are unsure about how to do this, an Internet
search can help you find out how to delete the cache on every supported browser.
2. Re-run saved Web reports and re-save them.
This ensures that the reports can be read correctly on the new system.

Upgrade Custom Device Drivers
Some LE device drivers (drivers that were downloaded) from the old SPM system may have
become Standard Edition (SE) drivers (i.e. default drivers) in PME 8.1. In such cases there
will be two entries in the device type list for the same type.
You can see these device type entries in the Management Console: one is an LE type carried
over from the earlier version; the other is the SE version that was installed during upgrade.

Manually changing the device type can unlink previously logged data. Therefore, an upgrade
to SE should be performed.
To upgrade the driver:
1. In Management Console right-click on the device instance to be upgraded, and
select Upgrade LE Device.
A warning message is displayed asking to confirm that it is okay to stop and restart
Services.
2. Click OK if this is acceptable.
Clicking OK executes the device upgrade. A message is displayed when the
upgrade is finished.
After you close the Upgrade status window, the device type of the instance will change.
For example from TeSysT to TeSys T:
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This procedure applies to both CE and LE drivers listed below. The list of drivers that need to
be upgraded in PME 8.1 include:

This may not be the complete list for all version upgrade paths.

Note: Any missing LE Drivers should be downloaded from the Schneider Electric
Exchange and Installed separately. Make sure you download PME 8.1 versions.
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Step 7 – Perform a Post-upgrade System Check
Verify that the PME 8.1 system is configured correctly. Use the checklist below to do a system walk through. For each item in the checklist, make sure the system behaves the way you
expect.
For example:
Is all the information present?
Are measurements being displayed and are they updating?
Are reports running and returning the expected data?
Are all devices configured and communicating?
Some of the new features in PME 8.1 need to be configured before they will provide the expected information or functions. Configuring these new features is not part of this document.
Refer to the PME 8.1 user documentation and other product resources for information on configuring these features.

Checklist
To perform a system walk through on your newly upgraded system:
1. Check the system log in the Management Console for errors.
2. Check the Devices, Sites, and other settings in Management Console.
3. Check the availability of the archived databases for reporting in the Reporting Configuration Manager in the Management Console.
4. Log into Vista, verify the network diagram, real time data, and data logs.
5. Check the data and functions provided by the VIPs.
6. Log into the Web Applications.
7. Run the reports, Diagrams, Tables and Dashboards.
8. In Web Reporter, run saved/custom reports and verify the report subscription.
9. Log into the Reporter (also known as RepGen) application and generate the saved
reports.
10. Check any scheduled tasks.
For maintenance, follow the standard maintenance best practices recommended for PME
8.1.
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Supplemental Information
The following PME 8.1 documents provide supplemental information to the instructions found
in this document and for the PME 8.1 software in general. The documents are available on the
Schneider Electric Exchange Web site or at www.schneider-electric.com.
What's New, document number 7EN12-0293.
Before Installing your Software, document number 7EN52-0383.
Using the SQL Server 2014 DVD, document number 7EN52-0391.
Installation Guide, document number 7EN02-0380.
User Guide, document number 7EN02-0379.
Power Monitoring Expert Design Guide, document number 7EN42-0118.
Power Monitoring Expert Licensing Quick Start Guide
Online information available in the product includes:
Power Monitoring Expert Help – Accessible from within installed components, such
as Management Console, Vista, and Designer.
Alarm Configuration Help – Accessible in a browser-based help format from the
Alarm Configuration user interface.
Hierarchy Manager Help – Accessible in a browser-based help format from the Hierarchy Manager user interface.
Web Applications Help – Accessible in a browser-based help format from the Web
Applications user interface.
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Default Device Drivers
Use the list of SPM 7.0.1 default device drivers to determine which device drivers were customized on the old system.
3300
3710
3720
3800
6200
6200_RTU
7300
7330
7350
7500
7500-RTU
7550
7550-RTU
7600
7650
7700
8300
8400
8500
8600
8650
8800
9200
9200_RTU
9300
9330
9340
9350
9360
9500
9500-RTU
9510
9510-RTU
9600
9610
9700
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Acti9Smartlink
BCPM
CM2000
CM3000
CM4000
COMPACTNSX_A
COMPACTNSX_E
DM6200
DM6300
EM1200
EM5600
iEM3150_3250
iEM3155_3255
MICROLOGIC_A
Micrologic_EMICROLOGIC_H
MICROLOGIC_P
Momentum_PLC_A8_WAGES
Momentum_PLC_D10_WAGES
PM1200
PM200
PM5350
PM600
PM700
PM800
PM9C
SEPAM10
SEPAM20
SEPAM40
SEPAM48
SEPAM80
Twido_Mod_PLC_WAGES_D12_D28_D44
VIGILOHM
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Troubleshooting
This section includes troubleshooting procedures known as of the publication date of this document.

ION_Network with Database Manager
Issue: When upgrading ION_Network with the Database Manager, you may see a time-out
message.

This time-out is due to a SQL configuration.
Resolution: Use the following workaround to resolve this and continue the upgrades:
Make sure you upgrade the ION_Data database first, before you upgrade the ION_
Network database. This usually resolves the time-out error.
If you still notice the time-out error, then re-run the ION_Network upgrade.
If neither of these two options resolves the issue, then you need to modify the SQL Server
Registry settings to a larger value using the Registry Editor.

Note: To change the registry setting, you must have administrative privileges.

To edit the registry:
1. Go to Start and select Run.
2. Type regedit in the Run text box and click OK. A Registry Editor window opens.
3. Select Computer and press Ctrl+F. In the Find what text box, enter
QueryTimeOutSeconds. The Registry Editor window highlights the
QueryTimeOutSeconds registry key.

© 2016 Schneider Electric. All rights reserved.

Page 85 of 100

Reference

4. Right-click the registry key and select Modify. An Edit DWORD window opens.
Note: Before you modify Value Data, be sure you make a note of the
default value data.

5. Select the Hexadecimal option button, and set the Value Data to 258 (OR) select the
Decimal option button, and set the Value Data to 600.

Once the upgrade is complete, it is recommended that you reset the registry to its original setting.
The time-out error may still prevail when there is NULL in a field that does not allow NULL.
This occurs in the Name column of ION_Network.dbo.Scheduler table.

To correct this:
1. Go to SQL Server Management Studio.
2. Select File > Open File.
3. Navigate to the \SBS Upgrade Package\SQL_Script_Files folder and open update_
Scheduler_Table.sql.
If a NULL value is found, the script will insert “-” in the Name column.
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Database Manager
Issue: The upgrade of ION_Data/ION_Network does not succeed and displays a message
that the ION_Data.mdf/ION_Network.mdf file already exists.
Resolution: The Database Logical Name needs to be different than ION_Data or ION_Network_Data, and the restore location needs to be …\Power Monitoring Expert\Database\Data.
Issue: The database upgrade finishes successfully, but some tables in ION_Data look corrupted with data missing.
Resolution: Make sure that tempdb can expand up to twice the size of the live database.
Issue: The upgrade did not succeed at the Verify Databases point due to custom measurements.
Resolution: Contact customer support; no resolution is available.

Upgrading Database Error
SPM 7.0.1 - Upgrade to PME 8.1 - Failed on Step: Checking Space
Issue: When trying to upgrade SPM 7.0.1 to PME 8.1, the process was unsuccessful at the
Checking Space step.
The following entries may be seen in the Error Log:
System.ArgumentException: Illegal characters in path.
at System.IO.Path.CheckInvalidPathChars(String path, Boolean checkAdditional)
at System.IO.Path.NormalizePath(String path, Boolean fullCheck,
Int32 maxPathLength, Boolean expandShortPaths)
at System.IO.Path.GetFullPathInternal(String path)
at System.IO.FileInfo.Init(String fileName, Boolean checkHost)
at System.IO.FileInfo..ctor(String fileName)
at Installer.InstallTools.ConfigureSQL.GetDBFilePhysicalPath
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(String dbName)
at Installer.InstallRequests.CheckDiskSpaceGenericRequest.DoJob()
executeQuery(SELECT filename FROM sysdatabases WHERE name = 'ION_
Data', master) Failed on exception:
\nSystem.InvalidCastException: Unable to cast object of type 'System.DBNull' to type 'System.String'.
at Installer.InstallTools.ConfigureSQL.ExecuteScalar(SqlCommand
command, String dbName)
Cause: SQL user ION needs Sysadmin level user privileges and the SQL Server services
need to be running under the "Local System" account.
Resolution: Complete these steps:
1. Login to SQL Management Console with a Sysadmin level user.
2. In Security\Logins, double click on the ION user to bring up the Login Properties window.
3. Select Server Roles, and check sysadmin on the right side, then click OK.
4. Open Windows Services.
5. Right-click on the SQL Server service and select Properties.
6. In the Properties window, select the Log On tab, check Log on as Local System
account, then click OK.
7. Do this to the SQL Agent also and then restart the SQL and SQL Agent services.
8. Re-run the upgrade.

Troubleshooting Vista
Issue: The Vista diagram does not open in the Engineering Client, even after the Engineering
Client license is applied to the server.
Workaround: For the Vista diagrams to open properly, first delete the trial license from the
server, and then apply the Engineering Client license to the server.
Issue: After completing the upgrade, Vista will not run. When it is launched, you see the
splash screen, but before you get to the login screen, Vista crashes. You see a dialog from
the operating system stating that Vista has stopped working.
Cause: This happens if your config\cfg\ud directory has a global.log file. Global.log is
a file that is created when you add a Global Event Viewer to Vista. The old file format from
ION Enterprise 6.0 or earlier is not compatible with PME 8.1 Vista.
Workaround: Delete global.log. You must re-add a Global Event Viewer if you want to
use it in your upgraded system.

Page 88 of 100

© 2016 Schneider Electric. All rights reserved.

Reference

Issue: You see a configuration error in the Vista diagrams as shown below. Possibly, the ION
and XML files have been updated in the new PME 8.1 system.
Cause: The Vista diagram refers to the old ION and XML files located at …\config\translator
folder.
Resolution: Delete the ION and XML files from the …\config\translator folder and re-do the
MDI configurations manually.

Troubleshooting Hierarchies
Issue: Hierarchies Sub Meter tab is missing, and version numbers do not match.
Resolution: Clear the web browser history and refresh the Hierarchies cache by opening
Hierarchies from Management Console. Log in and press Shift + F5. Then reset IIS by navigating to C:\Windows\System32 and double-click iisreset.exe.

Troubleshooting Alarms
Issue: A message occurs when the ION_Data database contains large number of unacknowledged events or the Web Applications is not able to properly access the alarm data.
Environment: Web Applications and Alarms Tab
Scenario / Resolution 1:
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This can happen if the upgraded database (ION_Data) contains a large number of unacknowledged events. To determine if there are a large number of unacknowledged events, run
the query below against ION_Data. This will return the number of unacknowledged events
with a timestamp greater than the timestamp you have chosen.

NOTICE
DATABASE DAMAGE
• Do not perform this procedure unless you are familiar with SQL Server Management Studio.
• Always back up databases prior to performing this procedure.
Failure to follow these instructions can result in irreparable database damage.
select COUNT(*)from vAlarmLog
where AckTimeUTC is null
and Priority > 127
and TimestampUTC > > '<some timestamp filter;'
To acknowledge all of these alarms quickly, without having to use the Alarms user interface,
!Execute the following query:
Declare @CurrentDateTime varchar ( max )
SET @CurrentDateTime = GETUTCDATE ()
INSERT INTO EventAcknowledgement (EventLogID ,AckTimeUTC ,UserName )
( SELECT a .ID , @CurrentDateTime , 'supervisor' from vAlarmLog a
where AckTimeUTC is null and Priority > 127 )
This query will use the present UTC date / time as the alarm acknowledgment, and supervisor as the account that performed the acknowledgment.
Once the alarms have been acknowledged, the Alarm Viewer will function normally. It is
recommended that you delete old, unwanted events to reduce the number of events that need
to be processed. Use the Trim function in Database Manager. Select Events and choose an
appropriate date range.
Scenario / Resolution 2:
If the server machine is on a workgroup, change the Schneider Electric services to run under
a local Windows administrator account, restart the services, perform an iisreset, and then
check to ensure that alarms are coming in successfully.
Scenario / Resolution 3:
Check the Windows Host file in the C:\windows\system32\drivers\etc\ directory and check
the localhost IP address. By default, webservices only allows access from 127.0.0.1, which
is the default localhost. If the address is different than the default, the locahost address
needs to be added to the webservices web.config file (such as <add
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ipAddress="10.70.20.81" allowed="true" />) where the IP address is found
within the Windows host file.
After changing and saving the \host file, restart the Schneider Electric services and perform an iisreset to verify that alarm and event data are coming in successfully.

Troubleshooting Reports
Issue: Reports do not display in the Report Library.
Possible Causes: Incorrect licensing or the custom web report packs are not installed, or
properly upgraded.
Resolution:
Obtain the correct licensing.
Install the upgraded custom web report packs or delete the custom report entries from the
database.
Custom web report packs were not upgraded
Review the following scenarios to understand the implications of not upgrading custom report
packs:
Scenario 1: If the old custom reports have not been upgraded (i.e. they are not compatible
with PME 8.1), none of the web reports will be visible in the Reports Web application.
To successfully perform the upgrade without the custom web reports:
1. Delete the custom reports (templates + saved instances) on the source system in the
Manage Reports UI (in Web Apps) before transferring the system.
2. Follow the standard SBS upgrade process.
The default reports on the new system will work as expected. Once the old report packs have
been upgraded, they can be uploaded and installed on the new system and they will work as
expected. (Internet Information Services (IIS) needs to be restarted.)
Scenario 2: The old system has a lot of saved custom reports and the client doesn't want
them deleted.
1. Try installing the old custom report pack from the source system on the target. If it
installs it might not work, however, the default reports will display. The SBS upgrade
can proceed.
Scenario 3: The field engineer completes the SBS upgrade with old, non-compatible custom
web reports. At this point, the target system will not display any reports.
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1. Determine which database table entries need to be deleted by opening the System
Log in Management Console or by looking at the database tables to identify the custom reports.
2. Delete the custom report entries from the RPT_Report table in the ION_Network
database.
The default reports on the new system will work as expected.

Data Log Viewer Query
Issue: After completing the upgrade, an error occurs when trying to modify a Data Log Viewer
query created in or earlier.
Cause: A space was inserted before the ‘@VCN’ node, and an older query will not have this
space.
Example: Old node name [Data Rec 1@VIP2@VCN *)--"]
Edited node name [Data Rec 1@VIP2 @VCN *)--"]
Workaround: Edit the node and add a space before the @VCN.

SQL User Mapping
In SQL Server Management Studio expand Security > Logins, select the Users (for
example, ION) and then right-click ION and select Properties.
The Login Properties-ION window opens. Select User Mapping and in the Users mapped to
this login section, select the appropriate Databases, User, and Default Schema based on the
following:

Logins

Database

EPSS_
ApplicationModule
DataCollector

AMUser
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User

Default
Schema

Role Membership

EPSS_
dbo
DataCollector

AMApplicationRole, public

ION_Data

EPSS_
dbo
DataCollector

Db_datacreader, EPSS,
DataCollectorAccess,
public

ION_Network

EPSS_
dbo
DataCollector

Db_datareader, public

ApplicationModules

AMUser

AMApplicationRole, public

Dbo
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Logins
ION

ionedsd

Report

Database

User

Default
Schema

Role Membership

ION_Data

dbo

dbo

Db_owner, public

ION_Network

dbo

dbo

Db_owner, public

ION_SystemLog

dbo

dbo

Db_owner, public

ION_Data

ionedsd

dbo

ION_DSD_Reader, public

ION_Network

ionedsd

dbo

NOM_DSD_Reader,
public

ION_Data

Report

dbo

db_datareader, ION_
Reader, public

Note: If a “user exists” message is observed during the user mapping process, contact Schneider Tech Support. They will probably have to delete the user from Security > Login > User(s).
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You can also use the following query to see if there are issues with the “user exists” message:
ALTER AUTHORIZATION ON DATABASE::ION_Data TO ION;

Engineering Client and Server(s) Communication
Once the Engineering Client installation is complete, follow these steps to ensure smooth
communication with the PME server(s):
1. On the Engineering Client, navigate to the $:\Windows\System32\drivers\etc directory.
2. Open the \hosts file and edit it by adding the following details in the relevant order:
Client Machine IPClient Machine long name
Client Machine IPClient Machine short name
Server Machine IPServer Machine long name
Server Machine IPServer Machine short name
For Example:
521.456.7.x clientName.<your domain>.com
521.456.7.xclientName
521.456.7.y serverName.<your domain>.com
521.456.7.yserverName
Distributed System Note: The \hosts file must be edited
in the primary server as well as the database server.

3. On the primary server, go to the …\Schneider Electric\Power Monitoring Expert folder on the server and enable Sharing to "Everyone."
Distributed System Note: Make the following changes on the Database
server.

4. On the PME standalone server, change the SQL Server Configuration Manager settings to establish the remote connections of the SQL server named instance (for
example, PMEServer\ION) with the Engineering client.
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5. Go to SQL Server Configuration Manager and click SQL Server Network configuration.
6. Expand the tree.
7. Click Protocols for IONE and enable the following options:
Shared Memory
Named Pipes
TCP/IP
Set VIA as disabled (by default)
Right-click TCP/IP
Go to Properties
Navigate to IP Addresses tab
Make IP3 IP address same as Engineering Client IP Address
Enable TCP port as 1433.
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8. Check the remote connections of the SQL server 2008 R2 named instance (for
example, PMEServer\ION) of the new PME server with Engineering Client as mentioned below.
9. In Engineering Client, open a new Notepad file and save it as a .udl file.
a. Open the UDL file; you need to manually enter the standalone server
name with the SQL instance name (for example, PMEServer\ION) if
it is not listed in the selection menu.
b. Select the Use Windows NT Integrated security radio button.
c. Select the ION_Data option from the Select the database on the
server dropdown list.

d. Click Test Connection.
Once the operation is complete, you will see a Test Connection succeeded window.
10. Install PME 8.1 on the Engineering Client.
If the following exception displays in the Diagnostic viewer on the Engineering Client:
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To fix the exception:
1. On the command line, create a new directory called $:\Windows\assembly\GAC\adodb\7.0.3300.0__b03f5f7f11d50a3a.
2. Copy the adodb.dll file located in the …\Schneider Electric\Power Monitoring Expert\system\bin folder to the newly created directory (\GAC).
3. Log in to the Diagnostic viewer and make sure that the device status is active.

Device Diagram Customizations
Issue: Customizations to default device diagrams are lost when the diagrams were moved to
the new system.
Cause: This issue can occur when a customized default device diagram on the old ION Enterprise system is configured to open from a grouping object that has the “Action” set to “Open
Diagram for Meter Template”.
This option will use an automatic mechanism in ION Enterprise to find the default device diagram based on the device type, firmware versions, and other settings. If the new system has
an updated version of the default device diagram and the automatic mechanism is used to discover it, then the new one will be opened which does not have the customizations.
Workaround:
Option 1: Change the links on the new system to link to the specific default device diagram
that was transferred over from the old system. Choose the option “Open User Diagram” in the
dialog and then select the relevant diagram from the old system. The advantage here is that
this requires relatively little time and effort. The downside is that you will not get the benefit of
any bug fixes that led to the creation of the new diagrams.
Option 2: Copy the customizations that were done to the old diagram to the new diagram in
PME 8.1. The advantage here is that you get any bug fixes that triggered the creation of the
new diagrams. The downside is that you have to manually recreate the customization.
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